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Chapter 405

Tests for One
Exponential Mean
Introduction
This program module designs studies for testing hypotheses about the mean of the exponential distribution. Such
tests are often used in reliability acceptance testing, also called reliability demonstration testing.
Results are calculated for plans that are time censored or failure censored, as well as for plans that use with
replacement or without replacement sampling. We adopt the basic methodology outlined in Epstein (1960), Juran
(1979), Bain and Engelhardt (1991), and Schilling (1982).

Technical Details
The test procedures described here make the assumption that lifetimes follow the exponential distribution. The
density of the exponential distribution is written as
f (t ) =

 t
exp − 
 θ
θ
1

The parameter θ is interpreted as average failure time, mean time to failure (MTTF), or mean time between
failures (MTBF). Its reciprocal is the failure rate.
The reliability, or probability that a unit continues running beyond time t, is
R( t ) = e

−

t

θ

Hypothesis Test
The relevant statistical hypothesis is H 0 : θ0 = θ1 versus the one-sided alternative H1: θ0 > θ1 . Here, θ0 represents an
acceptable (high) mean life usually set from the point of view of the producer and θ1 represents some unacceptable
(low) mean life usually set from the point of view of the consumer. The test procedure is to reject the null hypothesis
if the observed mean life θ is larger than a critical value selected to meet the error rate criterion.
The error rates are often interpreted in reliability testing as risks. The consumer runs the risk that the study will fail
to reject products that have a reliability less than they have specified. This consumer risk is β . Similarly, the
producer runs the risk that the study will reject products that actually meet the consumer’s requirements. This
producer risk is α .
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Fixed-Failure Sampling Plans
Fixed failure plans are those in which a specified number of items, n, are observed until a specified number of items,
r0 , fail. The length of the study t0 is random. Failed items may, or may not, be immediately replaced (with
replacement versus without replacement).
The test statistic is the observed mean life θ which is computed using

θ =

∑

ti
i = all test items
r0

where ti is the elapsed time that the ith item is tested, whether measured until failure or until the study is completed.
For both with-replacement and without-replacement sampling, θ follows the two-parameter gamma distribution
with density
g( y| r0 , θ ) =

r

1  r0  r0 −1 − r0 y / θ
  y e
r
( 0 − 1)!  θ 

This may be converted to a standard, one-parameter gamma using the transformation

x = r0 y / θ
However, because chi-square tables were more accessible, and because the gamma distribution may be
transformed to the chi-square distribution, most results in the statistical literature are based on the chi-square
distribution. That is, 2r0θ / θ is distributed as a chi-square random variable with 2r0 degrees of freedom.
Assuming that the testing of all n items begins at the same instant, the expected length of time needed to observe the
first r0 failures is
 r0
1
without replacement
θ
 i =1 n − i + 1
E (t0 ) = 
 θr0
with replacement
 n

∑

If you choose to solve the without replacement equation for n, you can make use of the approximation
r

 n + 0.5 

∑ n − i + 1 ≈ log  n − r + 0.5
1

e

i =1

Using the above results, sampling plans that meet the specified producer and consumer risk values may be found
using the result (see Epstein (1960) page 437) that r0 is the smallest integer such that

χα2 ,2r0
θ
≥ 1 for testing H1: θ0 > θ1
2
θ
χ1− β ,2r0
0
and

χ β2, 2r0
θ
≥ 0 for testing H1: θ0 < θ1
2
χ1− α , 2r0 θ1

405-2
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for One Exponential Mean

Note that the above formulation depends on r0 but not n. An appropriate value of n can be found by considering
E( t0 ) . Two options are available.

1. The value of n is set (perhaps on economic grounds) and the value of E( t0 ) is calculated.
2. The value of E( t0 ) is set and the value of n is calculated.

Fixed-Time Sampling Plans
Fixed Time plans refer to those in which a specified number of items n are observed for a fixed length of time t0 .
The number of items failing r is recorded. Sampling can be with or without replacement. The accept/reject decision
can be based on r or the observed mean life θ which is computed using

θ =

∑

ti
i = all test items
r

where ti is the time that the ith item is being tested, whether measured until failure or until the study is completed.

With Replacement Sampling
If failed items are immediately replaced with additional items, the distribution of r (and θ , since θ = nt0 / r )
follows the Poisson distribution. The probability distribution of r is given by the Poisson probability formula

P(r ≤ r0 | r , θ ) =

r

∑

( nt0 / θ )i e− nt

0

/θ

i!

i=0

Thus, values of n and t0 can be found which meet the α and β requirements.

Without Replacement Sampling
If failed items are not replaced, the distributions of r and θ are different and thus the power and sample size
calculations depend on which statistic will be used. The probability distribution of r is given by the binomial formula

P(r ≤ r0 | r , θ ) =

r

 n

∑  i  p (1 − p)
i

n−i

i= 0

where
p = 1 − e− t0 /θ

Thus, values of n and t0 can be found which meet the α and β requirements. Note that this formulation ignores
the actual failure times.
If θ will be used as the test statistic, power calculations must be based on it. Bartholomew (1963) gave the
following results for the case r > 0.

(

)

Pr θ ≥ θC =

1
1 − e − nt 0 / θ

∞

 n k  k 
i
 t

    ( − 1) exp  − 0 ( n − k + i) g( x )dx
k
i
θ





W
k =1
i= 0
n

∑

∑

∫
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where g(x) is the chi-square density function with 2k degrees of freedom and
W=

2k

θ

θC −

t0
( n − k + i)
k

 X if X > 0
X =
 0 otherwise
The above equation is numerically unstable for large values of N, so we use the following approximation also given
by Bartholomew (1963). This approximation is used when N > 30 or when the exact equation cannot be calculated.
Bain and Engelhardt (1991) page 140 suggest that this normal approximation can be used when p > 0.5
u np

z=
1−

2u(1 − p) log e (1 − p)
+ (1 − p)u2
p

where

u=

θ − θ
θ

p = 1 − e− t0 /θ

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment or test.

Test
Alternative Hypothesis
Specify the alternative hypothesis of the test. Since the null hypothesis is equality (a difference between theta0
and theta1 of zero), the alternative is all that needs to be specified. Usually, a one-tailed option is selected for
these designs. In fact, the two-tailed options are only available for time terminated experiments.
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Sampling Plan
Replacement Method
When failures occur, they may be immediately replaced (With Replacement) with new items or not (Without
Replacement). One of the assumptions of the exponential distribution is that the probability of failure does not
depend on the previous running time. That is, it is assumed that there is no wear-out. Adopting ‘with replacement’
sampling will shorten the elapsed time of an experiment that is failure terminated.
Termination Criterion
This option specifies the method used to terminate the study or experiment. There are two basic choices:
•

Fixed failures (r)
Terminate after r failures occur. This is also called failure terminated or Type-II Censoring.

•

Fixed time (t0)
Terminate after an elapsed time of t0. This is also called time terminated or Type-I Censoring. This is the
most common.

In fixed failure sampling, N may be fixed while t0 varies or t0 may be fixed while N varies. All that matters is the
product of these two quantities.
In fixed time sampling, two test statistics are available: r and theta-hat. When sampling is without replacement,
tests based on theta-hat are more powerful (require smaller sample size).
r (Number of Failures)
Enter one or more values for the rejection number of the test. If r or more items fail, the null hypothesis that
Theta0 = Theta1 is rejected in favor of the alternative the Theta0 > Theta1.
Note that this value is ignored for time terminated experiments, because the appropriate value is calculated. This
value is also ignored in some situations in failure terminated experiments.
t0 (Test Duration Time)
Enter one or more values for the duration of the test. This value may be interpreted as the exact duration time, t0,
or the expected duration time, E(t0), depending on the Termination Criterion and Replacement Method selected.
These values must be positive and in the same time units as Theta0 and Theta1.
E(t0) based on Theta1
When the experiment is failure terminated, the expected waiting time until r failures are observed, E(t0), is
calculated. This value depends on the value of theta, the mean life. When checked, E(t0) calculations are based on
Theta1. When unchecked, E(t0) calculations are based on Theta0. Either choice may be reasonable in a given
situation.

Power and Alpha
Power = 1–Beta (Beta is Consumer’s Risk)
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta (consumer’s risk) is the probability of a type-II error, which occurs when a
false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null
hypothesis of equal probabilities of the event of interest when in fact they are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha (Producer’s Risk)
This option specifies one or more values for the probability of a type-I error (alpha), also called the producer’s
risk. A type-I error occurs when you reject the null hypothesis of equal probabilities when in fact they are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
Enter one or more values for the sample size N, the number of items in the study. Note that the sample size is
arbitrary for sampling plans that are terminated after a fixed number of failures are observed.
You may enter a range such as 10 to 100 by 10 or a list of values separated by commas or blanks.

Effect Size
Theta0 (Baseline Mean Life)
Enter one or more values for the mean life under the null hypothesis. This is sometimes called the producer’s
mean life. This value is usually scaled in terms of elapsed time such as hours, days, or years. Of course, all time
values must be on the same time scale.
Note that the value of theta may be calculated from the estimated probability of failure using the relationship

P( Failure) = 1 − e − t 0 / θ
so that

θ=

− t0
ln(1 − P( Failure))

Only positive values are valid. You may enter a range of values such as ‘10 20 30’ or ‘100 to 1000 by 100.’
Because the exponential function is used in the calculations, try to scale the numbers so they are less than 100.
For example, instead of 720 days, use 7.2 hundreds of days. This will help to avoid numerical problems during the
calculations.
Theta1 (Alternative Mean Life)
Enter one or more values for the mean life under the alternative hypothesis. This is sometimes called the
consumer’s mean life. This value is usually scaled in terms of elapsed time such as hours, days, or years. Of
course, all time values must be on the same time scale.
Note that the value of theta may be calculated from the estimated probability of failure using the relationship

P( Failure) = 1 − e − t 0 / θ
so that

θ=

− t0
ln(1 − P( Failure))

Any positive values are valid. You may enter a range of values such as ‘10 20 30’ or ‘100 to 1000 by 100.’
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Because the exponential function is used in the calculations, try to scale the numbers so they are less than 100.
For example, instead of 720 days, use 7.2 hundreds of days. This will help to avoid numerical problems during the
calculations.

Example 1 – Power for Several Sample Sizes
This example will calculate power for a time terminated, without replacement study in which the results will be
analyzed using theta-hat. The study will be used to test the alternative hypothesis that Theta0 > Theta1, where
Theta0 = 2.0 days and Theta1 = 1.0 days. The test duration is 1.0 days. Funding for the study will allow for a
sample size of up to 40 test items. The researchers decide to look at sample sizes of 10, 20, 30, and 40.
Significance levels of 0.01 and 0.05 will be considered.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for One Exponential Mean procedure window by expanding Means, then One Mean,
then clicking on Test (Inequality), and then clicking on Tests for One Exponential Mean. You may then make
the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Ha: Theta0 > Theta1
Replacement Method.............................. Without Replacement
Termination Criterion .............................. Fixed Time using Theta-hat
t0 (Test Duration Time) ........................... 1
Alpha ....................................................... 0.01 0.05
N (Sample Size)...................................... 10 to 40 by 10
Theta0 (Baseline Mean Life) .................. 2
Theta1 (Alternative Mean Life) ............... 1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
Test Based on Theta-hat with Fixed Running Time t0 and Without Replacement Sampling.
H0: Theta = Theta0. Ha: Theta = Theta1 < Theta0. Reject H0 if Theta-hat ≤ ThetaC.
Time
Target
Actual Target Actual
Power
N
t0 Theta0 Theta1
Alpha
Alpha
Beta
Beta
0.21695
10
1.000
2.0
1.0
0.01000
0.01000
0.78305
0.45485
20
1.000
2.0
1.0
0.01000
0.01000
0.54515
0.67159
30
1.000
2.0
1.0
0.01000
0.01000
0.32841
0.80628
40
1.000
2.0
1.0
0.01000
0.01000
0.19372
0.46940
10
1.000
2.0
1.0
0.05000
0.05000
0.53060
0.71828
20
1.000
2.0
1.0
0.05000
0.05000
0.28172
0.86665
30
1.000
2.0
1.0
0.05000
0.05000
0.13335
0.93730
40
1.000
2.0
1.0
0.05000
0.05000
0.06270

Theta
C
0.7
1.0
1.1
1.2
1.0
1.2
1.3
1.4
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the size of the sample drawn from the population.
Alpha is the probability of rejecting a true null hypothesis.
Beta is the probability of accepting a false null hypothesis.
Theta0 is the Mean Life under the null hypothesis.
Theta1 is the Mean Life under the alternative hypothesis.
t0 is the test duration time. It provides the scale for Theta0 and Theta1.
r is the number of failures.
Summary Statements
A sample size of 10 achieves 22% power to detect the difference between the null hypothesis
mean lifetime of 2.0 and the alternative hypothesis mean lifetime of 1.0 at a 0.01000
significance level (alpha) using a one-sided test based on the elapsed time. Failing items are
not replaced with new items. The study is terminated when it has run for 1.000 time units.

This report shows the power for each of the scenarios. The critical value, Theta C, is also provided.

Plots Section

405-8
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for One Exponential Mean

These plots show the relationship between power and sample size.
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Example 2 – Validation using Epstein
Epstein (1960), page 438, presents a table giving values of r necessary to meet risk criteria for various values of
alpha, beta, theta0, and theta1 for the fixed failures case. Specifically, when theta0 = 5, theta1 = 2, beta = 0.05,
and alpha = 0.01, 0.05, and 0.10, he finds r = 21, 14, and 11. We will now duplicate these results.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for One Exponential Mean procedure window by expanding Means, then One Mean,
then clicking on Test (Inequality), and then clicking on Tests for One Exponential Mean. You may then make
the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ r
Alternative Hypothesis ............................ Ha: Theta0 > Theta1
Replacement Method.............................. Without Replacement
Termination Criterion .............................. Fixed Failures, Fixed E(t0)
t0 (Test Duration Time) ........................... 1
E(t0) based on Theta1 ............................ Unchecked
Power ...................................................... 0.95
Alpha ....................................................... 0.01 0.05 0.10
Theta0 (Baseline Mean Life) .................. 5
Theta1 (Alternative Mean Life) ............... 2

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
Test Based on Fixed Failures r, Fixed Expected Time E(t0), and Without Replacement Sampling.
H0: Theta = Theta0. Ha: Theta = Theta1 < Theta0. Reject H0 if r ≥ r0.
Time
Target
Actual Target Actual
Power
r0 / N
E(t0) Theta0 Theta1
Alpha
Alpha
Beta
Beta
0.95841 21/115
1.000
5.0
2.0
0.01000
0.01000 0.05000 0.04159
0.95956
14/77
1.000
5.0
2.0
0.05000
0.05000 0.05000 0.04044
0.96221
11/60
1.000
5.0
2.0
0.10000
0.10000 0.05000 0.03779

PASS calculates 21, 14, and 11 for r as in Epstein.
We should note that occasionally our results differ from those of Epstein. We have checked a few of these
carefully by hand, and in every case we have found our results to be correct.
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